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The university will ensure that all computer software and systems for public use will permit all persons with disabilities to acquire the same information, engage in the same interactions, and enjoy the same services with substantially equivalent ease of use as those without disabilities.

As referred to in the Electronic Information Technology (EIT) Accessibility Policy, these standards are a guideline meant to bring all EIT in compliance with the Rehabilitation Act Amendments of 1998 (508 Compliance). The law that requires federal and state agencies adhere to a minimal level of accessibility. “Electronic information and data must be equally accessible to individuals with and without disabilities.” In other words, making content that works for everyone, even individuals that have sight or hearing impairments.

According to the EIT policy all EIT must conform to certain accessibility standards. This document explains these standards.
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Technology is constantly evolving and accessibility standards, being dependent on this, will change over time. These standards will be reviewed and updated every two years as needed. 

The standards are drawn from the W3C Web Content Accessibility Guidelines (WCAG) and the Section 508 standards. While some of these standards make specific reference to web content, the underlying principles apply to all EIT. 

We recognize that there is not a universal standard which covers all EIT because technology is ever changing.

All public facing content must conform to current standards given in this document. 

All non-accessible documents posted on a public facing webpage shall have an alternative accessible format available.  For example, if posting an inaccessible journal article on a webpage, one may post an accessible version containing the same content as the document.

In general content is public facing when it is accessible from the World Wide Web. 

It is encouraged that internal facing content also adhere to the standards as best as possible. For example, when teaching a closed course, material must be accessible to all students. Should a person with a disability require an accessible version of any content you should be ready to provide such a version. It is therefore advised that you keep all your content as close to accessible as possible. In general, you should keep your audience in mind. 

If a student, faculty, or staff person discloses a disability and needs accessible content after a semester has started, the university has a Rapid Response Plan in place to assist the instructor for 10 business days while the instructor finds a permanent solution.

The following does not answer every question that one might have about how to make all types of content accessible. General principles are set forth and some specifics are addressed. The responsibility of the content creator is to do due diligence. Be mindful that people with disabilities have different experiences with assistive technology and disabilities are different.


Please contact the EIT Lab at EIT@ysu.edu for assistance.
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Methods to create accessible content varies based on the type of authoring tool.  Please visit The National Center on Disability and Access to Education website for detailed instructions to author accessible Word, PDF, PowerPoint and Excel documents. Instruction guides are found on the EIT Desktop Tools webpage. 
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Documents created using Microsoft Word or other word processors should follow best practices indicated below for accessibility.
· Structure allows a reader to navigate through a document using properly defined titles, subtitles and headings.  Use text Styles to add heading and organizational structure to your document.  Use of Styles feature enables easy use of the automatic Table of Contents tools found on the References Tab. 
· Create a Table of Contents for document with 3 or more pages.
· Lists are structural elements that are created using List Styles commands.  List styles include bulleted or numbered lists. 
· Figures are any graphic including photos, charts, graphs, clipart, etc.  Each figure must include alternative text to describe it.  Figures are also to be placed “in line with text” which is a Wrap Text property.
	Create Columns using the Columns Tools found on the Layout tab. Avoid using the Tab Key to format columns.  When using columns your document should read like a newspaper, top to bottom, left to right.
	Color and Contrast:  Strong contract is important for individuals with visual impairment.  If you emphasize any written words with color, you must communicate its importance in another manner.
	Tables have very specific design considerations for accessibility.
•	Use the Insert Table tool rather than drawing a table.
•	Give your table a title using the Caption tool.
•	Identify the header row using the Table Properties settings. 
•	Restrict the table to a single page because screen readers will not read a table split across the page.
•	Insert a Bookmark in the first cell of the table to identify the table structure for the reader.
· Use the Document Properties option to add the Document Title, Subject, Author, Keywords used for searching.  Set the Default Language as English.
· A screen reader does not read Text Boxes.  Please refrain from using them.
· Review your document for accessibility using the Check Accessibility command found on the File tab in Check for Issues listing. 
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PDFs produced from accessible documents, presentations and spreadsheets should generally be accessible when tagging is retained.  Video content embedded or linked in PDFs must follow accessibility guidelines for media indicated in this document.

Some software may not produce accessible PDF files. Use the PDF accessibility checker in Adobe Acrobat DC to check for accessibility issues.
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People who are blind or have low vision can understand your data more easily if you create your Excel workbooks and charts with accessibility in mind.  
· Images (pictures, clip art, Smart Art, shapes, charts, etc.) require alternative text descriptions.
· Use meaningful hyperlink text and ScreenTips.
· Use sufficient contrast for text and background color.
· Give all sheet tabs unique names and remove blank sheets.
· Use simple table structure and specify column header information.
· Avoid merging cells
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Slide layouts in PowerPoint provide the structure required for screen readers including headers, lists and proper reading order.  
· Images require alternative text descriptions. Do not include flashing images or text.
· Use the default font size based on the slide layout selected.  If necessary, use multiple slides to convey information.
· Color and Contrast should be taken into consideration.  Strong contract is important for individuals with various visual impairments.  If you emphasize any written words with color, you must communicate its importance in another manner.  Strong contract is important for individuals with various visual impairments.  If you emphasize any written words with color, you must communicate its importance in another manner.
· Slide transitions must be simple.  Avoid automatic slide transitions.
· Text boxes are the last items read by a screen reader.  Data in a text box could be taken out of context. 
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Documents created with Google Docs are accessible when they contain the structure of heading styles, images with alternative text and meaningful hyperlinks. 
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Plain text documents are accessible by screen readers because they do not contain any elements that require structural definition like tables, lists and images.  While plaintext is accessible by screen readers, it does not contain structure so should not be used for longer complex documents. 
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Documents produced by open source software, such as LibreOffice or OpenOffice, will produce accessible documents when following the general guidelines explained above. 
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It is generally not easy to create accessible documents that contain mathematical notation.  No universal standard currently exists describing what it means for mathematics in electronic form to be accessible. In HTML documents (such as online webpages, HTML and MathML or MathJax is somewhat readable using a screen reader and/or a narrator. And as such this type of content is a good option. Displaying mathematical notation as images is not accessible. Documents created using LaTeX can be converted into HTML files containing MathML or MathJax if the source file is available. Therefore, writing in LaTeX is a good option.

The equation editor in Microsoft Word does not in general produce documents that are accessible, and this should not be used.

As always you are required to work with the audience on arriving at an accessible version of the document. 
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All university related webpages must conform to the standards in this document. This includes departmental, individual, or organizational webpages even if hosted outside the university.

Being public facing, webpages must be accessible. All website content creators must be knowledgeable of accessibility requirements. As mentioned above, the general guidelines are drawn from the W3C Web Accessibility Guidelines (WCAG). 

Specific standards: 

· All web editors using Drupal (i.e., campus content management system) must receive training before editing their department site.
· All University web pages must contain text in the footer that reads “ADA Compliance” and links to the Electronic Information Technology (“EIT”) Accessibility Compliance” site located at http://www.ysu.edu/accessibility.
· All University web pages must be checked for accessibility using a tool such as the WAVE tool or WAVE Evaluation Tool plugin for Firefox or Chrome. See Section 508 Checklist, as a reference, from WebAIM. 
· Consult the Accessibility Requirements page for information on making your website ADA compliant. 
· All documents need to be accessible. See “Creating Accessible Documents Manual: A Detailed Guide” or Desktop Tools for tutorials.

Note: reference for Web Standards is the W3C Web Accessibility Initiative (WAI).
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Blackboard itself is considered accessible. As such content created using Blackboard is generally considered accessible. Content such as documents added to Blackboard should conform to the standards for that type of content. Blackboard has a feature called Ally that will help you check for accessibility issues with your documents. 
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In general captioning should be an option or a transcript must be provided for all videos. For example: If using a video that you can’t edit, providing a transcript is acceptable. In some cases for a visually impaired person, you may need to have a person give a visual description.
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Personal emails are not in general required to be accessible. Newsletters and mass emails meant for a general audience are required to be accessible. These communications must contain the non-discrimination notice and a notice that an accessible format is available.

The non-discrimination notice is:

Youngstown State University does not discriminate on the basis of race, color, national origin, sex, sexual orientation, gender identity and/or expression, disability, age, religion or veteran/military status in its programs or activities. Please visit Electronic Information Technology Accessibility website for contact information for persons designated to handle questions about this policy.
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The university has a procedure for acquiring, installing, and using software. As part of this procedure, an assessment of accessibility is made. Please contact procurement for further details. 

If you are considering adopting software outside the university procedure, you should contact the vendor (or author behind the software) for a statement on accessibility. The statement should in essence say that the software is compliant. If such a statement is not available, we recommend not using the software. Software installed on computers in computer labs should be accessible. Software installed on personal computers need not be accessible.
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Facebook and many other social media websites claim to be accessible. When a decision is made to use social media, one should check with the site for statements on accessibility. The principal is to do due diligence. Material posted to these sites should still conform to the standards in this document. The University of Minnesota has a webpage called Accessible U discussing accessibility of various social media platforms.
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In general captioning should be an option or a transcript should be provided. For example: If using a video that you can’t edit, providing a transcript is acceptable. 

[bookmark: _Toc13559812]Linking to external content
External websites may not be accessible. Please be prepared to provide an alternative format as needed. 
